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Основное, но не единственное назначение транспортной панели — управление записью и воспроизведением проекта Cubase SX. 
Транспортная панель (рис. 3.1.) может располагаться в любой части главного окна программы, она всегда находится над остальными окнами. Перемещать панель можно, ухватившись мышью за любую ее часть, свободную от элементов управления. Лучше всего для этой цели подходят пустые поля, расположенные около горизонтальных границ панели. 
Скрыть транспортную панель можно нажатием клавиши <F2> или выбрав команду главного меню Transport > Transport Panel. Чтобы вернуть транспортную панель на экран, следует повторно воспользоваться командой Transport > Transport Panel или нажать клавишу <F2>. 


На транспортной панели расположено несколько групп управляющих элементов. Вы можете настроить транспортную панель таким образом, чтобы отображались не все эти группы, а только те, которыми вы пользуетесь чаще всего. В контекстном меню, вызываемом щелчком правой кнопки мыши, можно выбрать, какие группы следует отображать, а какие нет. У каждой группы имеется свое название, однако на самой транспортной панели эти названия не отображаются. 
В нижней части контекстного меню имеется три команды: 

·  Buttons Only — отображать только кнопки деки (см. в разд. 3.1 определение деки); 

·  Time Display Only — отображать только поле координаты текущей позиции; 

·  Show All — отображать все элементы панели. 

Рассмотрим все группы транспортной панели в порядке убывания их важности (с нашей субъективной, естественно, точки зрения). 

3.1. Группа Main Transport

Основным элементом транспортной панели можно считать группу Main Transport (рис. 3.2). 
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Рис. 3.2. Группа Main Transport
В данной группе расположен ряд кнопок для управления записью/воспроизведением/перемоткой проекта. Обычно набор таких кнопок называют декой. Что значит "перемотка проекта"? В любом секвенсоре присутствует такое понятие, как текущая позиция. В режиме остановки (когда воспроизведения/записи не происходит) текущая позиция — это координата, начиная с которой будет осуществляться его воспроизведение и, как правило, запись. Отсчет координаты ведется от начала проекта. Во время воспроизведения/записи текущая позиция соответствует тому месту проекта, которое воспроизводится/записывается в данный момент. Во всех окнах Cubase SX, служащих для графического представления музыкальной информации и звука, присутствует указатель текущей позиции — специальный маркер в виде вертикальной линии. Во время воспроизведения этот маркер плавно перемещается слева направо — значение координаты текущей позиции увеличивается. В любой момент можно осуществить мгновенный (скачкообразный) или просто быстрый переход в нужную позицию проекта. По аналогии с магнитофоном это и означает "перемотать" проект. В Cubase SX для быстрого перемещения по проекту имеется множество средств. Одно из них — дека. 
На практике управлять процессом записи/воспроизведения, нажимая с помощью мыши виртуальные кнопки деки, не очень удобно. Поэтому действие большинства из кнопок деки дублируется определенными клавишами 
на дополнительной цифровой клавиатуре компьютера. Причем не имеет значения, включен ли на дополнительной клавиатуре режим Num Lock или нет, клавиши все равно работают. Перечислим кнопки деки слева направо с указанием соответствующих клавиш: 
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  (Go to project start) <.> — перемещение в начало проекта; 
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  (Rewind) <-> — перемотка к началу проекта; 
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  (Fast Rewind) <+> — перемотка от начала проекта; 
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 (Go to project end) — перемещение в конец проекта; 
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 (Stop) <0> — остановка воспроизведения/записи; 
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 (Play) <Enter> — воспроизведение проекта; 
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 (Record) <*> — запись треков, у которых включен атрибут Record Enable. Над кнопками деки располагается поле, в котором в различных формах отображена и доступна для изменения текущая позиция проекта. Одна из возможных форм — цифровая. На рис. 3.2 текущая позиция проекта представлена набором из 11 цифр в формате такт.доля.часть доли.тик (120 тиков в шестнадцатой доле). Подробно особенности такого формата представления времени описаны в разд. Т. 13.5. 
Щелчком на символе [image: image9.png]


расположенном в правой части поля текущей позиции, открывается меню, в котором можно выбрать нужный формат представления времени. Каждому из форматов соответствует свой символ, который отображается справа от цифрового представления текущей позиции проекта. Перечислим доступные форматы:

·  Bars + Beats ([image: image10.png]


) — "музыкальный формат" такт.доля.часть доли.тик (данный формат задан по умолчанию); 

· Seconds ( [image: image11.png]


) — линейный формат времени часы:минуты:секунды.миллисекунды; 

· 24 fps ( [image: image12.png]


) — формат времени, принятый в 35-миллиметровом кино, часы:минуты:секунды:кадры (24 кадра в секунду); 

· 25 fps ( [image: image13.png]


) — телевизионный формат времени, принятый в Европе, часы:минуты:секунды:кадры (25 полных кадров в секунду для стандартов PAL и SECAM); 

· 29.97 fps ([image: image14.png]


) — телевизионный формат времени, принятый в США и Японии, часы:минуты:секунды:кадры (29.97 кадров в секунду для стандарта NTSC); 

· 30 fps ([image: image15.png]


) — формат времени 30 кадров в секунду (используется в США только для работы со звуком); 

· 29.97 dfps ([image: image16.png]IT2s



) — формат времени NTSC с применением системы Drop Frame, когда каждый 1000-й кадр отбрасывается (29.97 кадров в секунду). Данный формат часто используется в США при работе с видео; 

· 30 dfps ([image: image17.png]Ilzo



) — формат, аналогичный предыдущему, за исключением частоты кадров, которая составляет 30 кадров в секунду. Данный формат используется очень редко; 

· Samples ([image: image18.png]


) — формат, представляющий собой одно число — количество звуковых отсчетов. 

В различных ситуациях удобнее использовать различные форматы представления времени. Например, если вы работаете над аранжировкой, в которой преобладают MIDI-данные, удобнее работать в формате Bars + Beats. Формат Samples более удобен при сведении аудиотреков или в процессе мастеринга. Если с помощью Cubase SX создается звуковая дорожка к видеотреку, импортированному в проект командой главного меню File > Import > Video File, то удобнее работать с телевизионными форматами времени. В таком случае следует выбрать тот же формат представления времени, что и в импортированном видеофайле. Простейший способ узнать этот формат — заглянуть в свойства видеофайла средствами Windows и посмотреть, какая там используется частота кадров. 
В левой части поля текущей позиции расположены символы + и —. Щелкая на них с помощью левой кнопкой мыши, можно увеличивать или уменьшать значение текущей позиции на одну элементарную для действующего формата представления времени единицу. 
Вы можете ввести новое значение текущей позиции с клавиатуры: щелкаете на нужном разряде (разряд станет выделенным), вводите с клавиатуры новое значение (выделение перемещается к следующему разряду). Под разрядом в данном случае мы понимаем группу цифр, расположенных подряд и отделенных точкой (.) или двоеточием (:) от остальных разрядов. 
Имеется возможность плавного изменения значений разрядов. Для этого надо подвести курсор мыши к верхней или нижней части нужного разряда так, чтобы курсор принял вид [image: image19.png]


или [image: image20.png]


соответственно. Если теперь нажать и удерживать нажатой левую кнопку мыши, значение разряда будет плавно увеличиваться или уменьшаться. Одиночный щелчок изменяет значение разряда на единицу. 
Если требуется перемещаться по проекту на большие расстояния, то удобнее пользоваться специальным ползунком-диаграммой [image: image21.png]


расположенным в нижней 'части поля текущей позиции проекта.

3.2. Группа Locators

В проекте Cubase SX всегда присутствуют два специальных маркера, называемых левым и правым локаторами. С помощью них обозначается отрезок проекта. Для чего? Например, для того, чтобы воспроизводить этот отрезок в цикле или экспортировать в звуковой файл. Множество функций Cubase SX работают применительно к отрезку проекта, заключенному между локаторами. По умолчанию оба локатора находятся в самом начале проекта — точке с координатами 0001.01.01.000 (формат времени Bars + Beats). 
Позиции левого (L) и правого (R) локаторов доступны для редактирования в группе Locators, показанной на рис. 3.3. Для того чтобы перенести текущую позицию проекта на место левого или правого локатора, удобно пользоваться кнопками L либо R или клавишами <1> или <2> на дополнительной цифровой клавиатуре. 
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Рис. 3.3. Группа Locators
В группе Locators расположены четыре кнопки: 
AQ — включение/выключение режима автоматической квантизации (квантизации подвергаются все записываемые MIDI-сообщения типа Note); 
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(punch in) — автоматическое переключение в режим записи из режима воспроизведения при достижении указателем текущей позиции левого локатора; 
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(Loop) — включение/выключение режима циклического воспроизведения/записи; 
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(punch out) — автоматический переход из режима записи в режим вос- произведения при достижении указателем текущей позиции правого локатора. В разд. 4.4.3 мы расскажем о применении перечисленных выше кнопок на практике. 

3.3. Группа Pre-/Post-Roll

Группа Pre-/Post-Roll (рис. 3.4) содержит два числовых параметра: Preroll (в верхней части) и Postroll (в нижней части). Оба параметра связаны с работой программы в режиме записи. 
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Рис. 3.4. Группа Pre-/Post-Roll
Программа будет "обращать внимание" на значение этих параметров в том случае, если в главном меню включена опция Transport > Use Pre-/Post-Roll. 
Значение Preroll используется следующим образом. В случае включения режима записи кнопкой деки
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(Record) или клавишей <*> Cubase SX фактически будет выполнять следующие действия: 

·  "перемотку" текущей позиции проекта по направлению к началу проекта на интервал времени, указанный в поле Preroll; 

·  запуск воспроизведения; 

·  переключение в режим записи при достижении указателем текущей позиции проекта того места, с которого сразу должна была бы начаться запись, если бы не был задействован режим Preroll. 

Короче говоря, можно считать, что значение поля Preroll — это время, выделенное на то, чтобы, готовясь к записи, собраться с духом. 
Заметить работу режима Postroll можно только в том случае, если включена опция Stop after Automatic Panch Out (остановка воспроизведения после автоматического выхода из режима записи), доступная в разделе Transport окна Preferences, вызываемого командой главного меню File > Preferences. 
При включенном режиме punch out (кнопка [image: image28.png]


) запись будет продол- 
жаться до тех пор, пока указатель текущей позиции проекта не поравняется с позицией правого локатора. Затем в течение времени, заданного параметром Postroll, будет осуществляться воспроизведение проекта. По прошествии данного времени воспроизведение будет автоматически остановлено. 
Для чего такие сложности? Многочисленные "мелочи", всевозможные опции и режимы могут сделать работу в Cubase SX более комфортной. Речь, естественно, идет о повседневном профессиональном применении программы. 

3.4. Группа Master + Sync

В группе Master + Sync доступны кнопки включения/выключения метронома и различных режимов, связанных с синхронизацией, а также поля, служащие для отображения и редактирования темпа и музыкального размера проекта. 
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Рис. 3.5. Группа Master + Sync
Нажатием на кнопку Click (или командой главного меню Project > Metronome On, или клавишей <С>) включается/выключается метроном. Окно настройки метронома вызывается командой главного меню Project > Metronome Setup (см. разд. 2.8). 
Кнопка Master включает/выключает режим, в котором управление темпом воспроизведения/записи осуществляется специальным треком проекта, называемым Tempo Track. Окно этого трека вызывается командой главного меню Project > Tempo Track или комбинацией клавиш <Аlt> + <9> (см. главу 7). Фактически Tempo Track представляет собой график изменения темпа во времени. 
Кнопка Sync (или команда главного меню Transport > Sync Online, или клавиша <Т>) — включение/выключение режима синхронизации с внешним оборудованием. Настройка параметров синхронизации осуществляется с помощью окна Synchronization Setup, вызываемого командой главного меню Transport > Sync Setup (см. разд. 2.9). 
Справа от перечисленных кнопок расположено поле, служащее для отображения и редактирования следующих параметров: 

·  Темп (доступен для редактирования, если только выключен режим Master); 

·  Музыкальный размер. 

Кроме того, в поле располагается индикатор синхронизации с внешним оборудованием, который служит для отображения следующих состояний: Offline (отсутствие синхронизации), Idle (готовность к синхронизации) и Lock NN (синхронизация установлена, NN — формат, количество кадров в секунду). 
Конечно, программа Cubase SX рассчитана на работу в составе студии, оснащенной всевозможным оборудованием, требующим синхронизации (например, многоканальные магнитофоны, видеомагнитофоны и т. п.). Если же речь идет о применении Cubase SX в качестве самостоятельной виртуальной студии на базе компьютера, то все возможные проблемы синхронизации с внешним оборудованием отпадают сами собой в связи с отсутствием последнего. 

3.5. Группы Record Mode и Activity

Следуя логике изложения, мы обязаны упомянуть, хотя бы формально, о том, что на транспортной панели имеется группа Record Mode (рис. 3.6). Она служит для переключения режимов записи. Однако рассмотрение особенностей этих режимов на данном этапе изучения программы не имеет смысла. О них мы расскажем в разд. 4.4.3.
В группе Activity (рис. 3.7) расположены два индикатора, отображающие активность входных (In) и выходных (Out) MIDI-портов. Осуществляется индикация процесса обмена только с внешними по отношению к Cubase SX MIDI-устройствами. 
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Рис. 3.6. Группа Record Mode
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Рис. 3.7. Группа Activity
Под внешними MIDI-устройствами следует понимать любые устройства, взаимодействие с которыми осуществляется через программные порты, доступные в системе. Например, встроенный в звуковую карту синтезатор/сэмплер считается не чем иным, как внешним MIDI-устройством. После установки драйверов звуковой карты в системе среди прочих портов появляется MIDI-порт для передачи данных встроенному синтезатору. 
Однако виртуальные MIDI-порты, возникающие после подключения VSTi к проекту, относятся только к Cubase SX, соответственно VSTi — внутренние (для Cubase SX) MIDI-устройства.

